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ABSTRAKSI : Sekarang ramalan banyak kita jumpai berbagai macam jenis seperti Ramalan melalui
wajah, Ramalan garis tangan, Ramalan kartu tarot, Ramalan bintang dan lain sebagainya. Ramalan
merupakan suatu permainan menghitung atau melihat nasib seseorang yang di lihat dari kepribadian,
Asmara, Kesehatan dan keberuntungan. Mungkin sebagian masyarakat ada yang benar-benar percaya
akan Ramalan tetapi sebagian juga tidak percaya dan hanya menganggap itu sebagai hiburan atau
permainan saja. Dan semua itu tidak menutup kemungkinan akan dampak positif dan negatifnya dari hasil
Ramalan tersebut. Orang kebanyakan mengenal ramalan bintang itu secara langsung baik melalui media
cetak, media elektronik ataupun kontak langsung bersama orang atau peramal yang bersangkutan.
Sedangkan kita ketahui bahwa ramalan itu sendiri merupakan sesuatu yang bersifat pribadi yang mungkin
sebagian orang memilih untuk diramal tidak diketahui oleh orang lain. Maka dari itu, untuk memudahkan
pengguna jasa ramalan akan di buat Aplikasi ramalan Bintang yang sifatnya interaktif yang dengan
mudah pengguna dapat menyimpannya didalam komputer atau laptopna sendiri . Karena orang-orang
mungkin sebelumnya menggunakan Aplikasi Ramalan yang biasa-biasa saja yang hanya terdapat tulisan
saja di dalamnya dan juga seperti yang kita ketahui kebanyakan Aplikasi ramalan di buat menggunakan
Bahasa pemrograman BASIC yang sebenarnya itu sangat rumit dan sulit untuk di buat. Jadi disini,
pengguna jasa ramalan dapat menggunakan Aplikasi Ramalan yang belum pernah ada dan mungkin
sebagian orang belum mengetahuinya yaitu dengan dibuatnya Aplikasi Ramalan bintang berbasis
multimedia yang sifatnya interaktif.

Tujuan dari pembuatan Aplikasi Ramalan adalah Ramalan tersebut dapat digunakan sebagai
alternatif dari Aplikasi Ramalan yang ada, serta sebagai sarana atau media hiburan yang bersifat
interaktif. Manfaat dari penelitian ini adalah Untuk mengembangkan pengetahuan tentang dunia Ramal-
meramal, Untuk dijadikan sebagai acuan atau pilihan positif dari isi ramalan dalam menghadapi
kehidupan esok, serta Menambah wawasan dan pengalaman khususnya dalam bidang hiburan

Metodologi penelitian yang digunakan adalah Metode Kepustakaan, Metode Perancangan, yaitu
menentukan proses halaman isi atau hasil ramalan dengan menghitung selisih nama, tanggal lahir dan
tahun yang akan di implementasikan ke dalam bentuk Aplikasi Ramalan dengan menggunakan Komputer
Multimedia, Metode Uji coba, Metode Implementasi

Dalam penelitian ini juga akan diuraikan mengenai tahap pembuatan gambar Background,
Animasi, pemberian action script dan pemberian sound atau musik sampai Implementasi pada akhir
proses pembuatannya. Sehingga dengan adanya penelitian ini diharapkan Aplikasi Ramalan ini dapat
menjadi hiburan dan diambil nilai positif dari tampilan yang ada.

Kata Kunci : Ramalan Bintang, Multimedia

1. LATAR BELAKANG MASALAH Mereka tidak pernah benar-benar menguiji

Sekarang ramalan banyak kita jumpai
berbagai macam jenis seperti Ramalan melalui
wajah, Ramalan garis tangan, Ramalan kartu
tarot, Ramalan bintang dan lain sebagainya.
Ramalan  merupakan suatu  permainan
menghitung atau melihat nasib seseorang
yang di lihat dari kepribadian, Asmara,
Kesehatan dan keberuntungan. Mungkin
sebagian masyarakat ada yang benar-benar
percaya akan Ramalan tetapi sebagian juga
tidak percaya dan hanya menganggap itu
sebagai hiburan atau permainan saja. Dan
semua itu tidak menutup kemungkinan akan
dampak positif dan negatifnya dari hasil
Ramalan tersebut. Maka membuat ramalan itu
sangat mudah, karena orang-orang yang
percaya ramalan itu biasanya menyukai
ramalan hanya karena ia adalah ramalan.

ramalan tersebut, tidak juga menuntut sang
peramal untuk membuat ramalan yang bisa
terukur secara kuantitatif dan objektif. (Nawawi-
2007)

Orang kebanyakan mengenal ramalan
bintang itu secara langsung baik melalui media
cetak, media elektronik ataupun kontak langsung
bersama orang atau peramal yang bersangkutan.
Sedangkan kita ketahui bahwa ramalan itu sendiri
merupakan sesuatu yang bersifat pribadi yang
mungkin sebagian orang memilih untuk diramal
tidak diketahui oleh orang lain. Maka dari itu,
untuk memudahkan pengguna jasa ramalan akan
di buat Aplikasi ramalan Bintang yang sifatnya
interaktif yang dengan mudah pengguna dapat
menyimpannya didalam komputer atau laptopna
sendiri . Karena orang-orang  mungkin
sebelumnya menggunakan Aplikasi Ramalan
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yang biasa-biasa saja yang hanya terdapat
tulisan saja di dalamnya dan juga seperti yang
kita ketahui kebanyakan Aplikasi ramalan di
buat menggunakan Bahasa pemrograman
BASIC yang sebenarnya itu sangat rumit dan
sulit untuk di buat. Jadi disini, pengguna jasa
ramalan dapat menggunakan  Aplikasi
Ramalan yang belum pernah ada dan mungkin
sebagian orang belum mengetahuinya yaitu
dengan dibuatnya Aplikasi Ramalan bintang
berbasis multimedia yang sifatnya interaktif.

. RUMUSAN MASALAH

Belum adanya Aplikasi Ramalan Bintang
yang berbasis Multimedia

Aplikasi Ramalan Bintang yang mudah dan
menarik dengan berbasis Multimedia?

=N

N

. MANFAAT PENELITIAN

Untuk mengembangkan pengetahuan

tentang dunia Ramalan Bintang

2. Dapat memberikan sumbangan pikiran
sebagai bahan informasi atau masukan
untuk masyarakat

3. Menambah wawasan dan pengalaman

khususnya dalam bidang hiburan.

= W

4. Astrologi dan Astronomi

Astrologi adalah ilmu tradisi yang
mempelajari  tentang  hubungan  antara
kejadian-kejadian di bumi dengan posisi dan
pergerakan benda-benda langit misalnya
matahari, bulan dan planet-planet serta
bintang-bintang. IlImu ini berkembang sudah
sejak sekitar 4000 tahun yang lalu dimulai dari
Mesopotania sebuah negeri di Timur Tengah
lalu berkembang ke Eropa, Amerika serta Asia.
Pakar astrologi dinamakan astrolog. Astrolog
yang cukup tersohor adalah Nostradamus dari
Perancis yang terkenal dengan bukunya yang
berjudul 'Centuries' berisi tentang 'Ramalan
Nostradamus' -- walau sejauh ini tidak banyak
terbukti .

Seiring dengan perkembangan ilmu
pengetahuan maka astrologi pun turut
berkembang. Pada awalnya astrologi dan
astronomi merupakan satu kesatuan ilmu,
namun pada abad 17 astrologi mulai
dipisahkan dari astronomi dikarenakan metode
yang digunakan para astrolog tidak mengikuti
kaidah-kaidah ilmiah, bahkan di Barat astrologi
tidak hanya mendapat perlawanan dari para
iimuwan tapi juga Gereja karena dianggap
melanggar ajaran agama.

Lain halnya dengan astronomi, ilmu ini
mempelajari alam semesta dan benda-benda

langit didasarkan pada metode serta perhitungan
secara ilmiah. Perhitungan ini berdasarkan hasil
pengamatan dan pengukuran dengan ketelitian
yang tinggi serta menggunakan alat-alat observasi
yang canggih seperti teleskop, satelit dan
pengiriman pesawat angkasa serta pengolahan
data menggunakan komputer sehingga
pergerakan benda-benda langit bisa diperkirakan
secara pasti baik untuk kondisi masa yang lalu
maupun kondisi masa yang akan datang.

Kini program peta langit dan simulator
planetarium untuk menghitung secara presisi
posisi pergerakan benda-benda langit banyak
bertebaran di internet, salah satunya adalah
program . Dengan bantuan program ini
kita dapat mengetahui dengan akurat posisi
semua benda langit dari hari ke hari dari 100.000
tahun yang lalu hingga 100.000 tahun yang akan
datang. Tingkat akurasi program ini sudah teruji
melalui serangkaian peristiwa astronomis seperti
gerhana, fase bulan, pergerakan planet, bulan dan
matahari maupun bintang-bintang. Astronomi juga
berkembang pesat dengan serangkaian misi-misi
pesawat antariksa dalam upaya eksplorasi alam
semesta demi kemakmuran umat manusia. Kalau
astrologi mengenal hanya 12 rasi yang disebut
zodiak, maka astronomi membagi bola langit
dengan 88 rasi termasuk di dalamnya 12 zodiak,
29 rasi langit Selatan dan 47 rasi langit Utara
dengan nama dan batas-batas yang telah
disepakati melalui Internasional Astronomical
Union (JAU) tahun 1921. Astronom (pakar dalam
bidang astronomi) menggunakan rasi-rasi tersebut
untuk kepentingan ilmiah seperti pemetaan
bintang, galaksi dan nebula serta pendataan
posisi penemuan benda langit. Kini astronom tidak
hanya para profesional yang memang latar
belakang pendidikan khusus dalam bidang
astronomi namun banyak muncul pula astronom
amatir yaitu para pecinta ilmu astronomi dari
kalangan masrakat umum yang juga banyak
memberikan kontribusi dalam kemajuan ilmu
astronomi.

Dalam  perkembangannya  ternyata
astrologi justru lebih populer dari pada astronomi.
Hingga  kini  bahkan beberapa  astrolog
mengkhususkan diri dalam Astrologi Kesehatan
(Medical Astrology), sementara yang lain
menggunakan astrologi untuk menelaah gejala-
gejala finansial dalam bisnis dan bursa efek
(Financial Astrology). Astrologi Duniawi (Mundane
Astrology) adalah tentang politik dan peristiwa
dunia, sementara Astrologi Pemilihan (Electional
Astrology) digunakan untuk membantu orang
menemukan waktu atau hari yang tepat untuk
menikah, mendirikan usaha, memulai pekerjaan
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baru dan lain-lain. Astrologi Pertanyaan
(Horary Astrology) menjawab pertanyaan-
pertanya an tentang masa lampau, sekarang
dan masa yang akan datang berdasar pada
saat-saat mereka muncul dalam pikiran si
penanya. Walaupun demikian, di antara semua
aliran astrologi yang paling populer adalah
Astrologi Kelahiran (Natal Astrology), vyaitu
jenis astrologi yang menganalisa kepribadian
dan potensi kehidupan seseorang berdasar
pada tanggal, waktu dan tempat kelahiran.

Astrologi mengklaim bahwa posisi
benda langit saat seseorang dilahirkan dapat
mempengaruhi watak dan kepribadiannya
bahkan nasibnya dikemudian hari. Walaupun
hal ini sudah ditolak mentah-mentah oleh para
saintis karena sangat tidak ilmiah sehingga
dianggap sebagai 'pseudo science' kayaknya
sains tapi bukan. Namun demikian berjuta-juta
orang di dunia masih saja banyak yang
percaya dan mempraktekkannya. Bahkan
klaim tidak hanya sebatas itu saja bahkan
posisi tersebut diyakini dapat mempengaruhi
kondisi bumi secara geologis misalnya
peristiwa gempa bumi, gunung meletus, banjir
danperistiwaalamlainnya.

Astrolog memiliki perlengkapan yang
disebut Horoskop yaitu sebuah gambaran peta
langit dengan bumi berada di pusatnya dan
dikelilingi oleh pita melingkar bergambar 12
rasi bintang yang disebut zodiak. Rasi zodiak
ini membagi persis lingkaran 360° menjadi 12
bagian sehingga masing-masing lebarnya 30°.
Ke 12 rasi zodiak itu adalah Aries, Taurus,
Gemini, Cancer, Leo, Virgo, Libra, Scorpio,
Sagitarius, Capricorn Aquarius, dan Pisces.
Horoskop dibuat oleh para astrolog untuk
mengetahui dimana posisi matahari saat
seseorang dilahirkan. Ini adalah salah satu
aliran astrologi yang paling populer dan paling
banyak penggemarnya termasuk di Indonesia.
Kenapa mereka membagi lingkaran langit
menjadi 12 sama persis, ternyata alasannya
adalah hal itu sudah merupakan kesepakatan
dari tradisi turun temurun sejak Claudius
Ptelomeus mengenalkan horoskop tersebut
memasuki abadke-2.

Kenapa hal ini dapat terjadi?
Jawabannya adalah perjalanan waktu akibat
peristiwva yang disebut yang
menjadi penyebab. Seiring perjalan waktu dari
tahun ke tahun dan dari abad ke abad
berikutnya terjadi pergeseran terhadap titik
Aries (Ekuinox) yang menjadi acuan awal
durasi zodiak ini akibat presesi bumi. Besarnya
pergeseran tersebut memang sangat kecil

yaitu 0,0139° setiap tahun tapi jika itu terjadi
selama 2000 tahun yang lalu hingga sekarang (
2000 x 0,0139° = 27,8° ) sehingga yang disebut
titik Aries kini tidak lagi terletak di rasi Aries
melainkan sudah bergeser di rasi Pisces dan akan
terus bergeser. Nantinya setelah 25.800 tahun
berlalu titik ini akan kembali lagi di rasi Aries.
Artinya tanggal yang menjadi pedoman horoskop
bergeser cukup jauh dari rasinya, sebuah angka
tidak pernah diperhitungkan oleh para astrolog.
Namun demikian apa yang menjadi pedoman para
astrolog kini sudah tidak relevan lagi jika
dicocokkan dengan dengan kondisi sekarang
artinya tanggal-tanggal seperti tercantum dalam
masing-masing Zodiak tersebut tidak sama lagi
kondisinya secara astronomis dengan waktu
sekarang. Bahkan ternyata pita zodiak kini tidak
hanya terdiri dari 12 rasi saja akan tetapi pada
periode tertentu matahari juga melewati rasi non
zodiak yaitu rasi Ophiuchus yang berada diantara
Scorpius dan Sagitarius, sehingga seharusnya
Ophiuchus menjadi zodiak ke-13.

Kenapa hal ini dapat terjadi? Jawabannya adalah
perjalanan waktu akibat peristiwa yang disebut

yang menjadi penyebab. Seiring
perjalan waktu dari tahun ke tahun dan dari abad
ke abad berikutnya terjadi pergeseran terhadap
titik Aries (Ekuinox) yang menjadi acuan awal
durasi zodiak ini akibat presesi bumi. Besarnya
pergeseran tersebut memang sangat kecil yaitu
0,0139° setiap tahun tapi jika itu terjadi selama
2000 tahun yang lalu hingga sekarang ( 2000 x
0,0139° = 27,8° ) sehingga yang disebut titik Aries
kini tidak lagi terletak di rasi Aries melainkan
sudah bergeser di rasi Pisces dan akan terus
bergeser. Nantinya setelah 25.800 tahun berlalu
titik ini akan kembali lagi di rasi Aries. Artinya
tanggal yang menjadi pedoman horoskop
bergeser cukup jauh dari rasinya, sebuah angka
tidak pernah diperhitungkan oleh para astrolog. Ini
barangkali yang perlu dipertanyakan kepada
mereka yang masih saja percaya dengan
ramalan-ramalan bintang yang banyak menghiasi
majalah, tabloid, surat kabar dan media-media
lain. Alasan mempertahankan tradisi untuk
menggunakan horoskop tidak menyelesaikan
masalah sebab kini orang sudah tahu bahwa
horoskop ternyata hanya bualan dan isapan
jempol belaka.

Satu pondasi penting yang menjadi dasar
perhitungan para astrolog sudah nyata-nyata
keliru, belum lagi masalah zodiak ke-13 (rasi
Ophiuchus) para astrologpun masih belum mau
mengakui. Kalau toh tidak masuknya Ophiuchus
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dikarenakan astrolog punya definisi tersendiri
mengenai  Zodiak sehingga bisa saja
Ophiuchus ini menjadi bagian dari Scorpius,
namun yang tidak bisa lagi dibantah adalah
kesalahan mereka tentang posisi matahari
dalam horoskopnya.

Namun kenyataannya masih saja
astrologi menjadi dagangan yang laris. Inilah
kepiawaian para astrolog mengolah dan
bermain kata-kata sehingga bisa banyak
mempengaruhi para pembacanya. Seolah apa
yang ia katakan lebih banyak benarnya dari
pada salahnya, padahal sebenarnya justru
sebaliknya atau bahkan tidak ada yang benar
sama sekali.

Bagi beberapa agama, percaya dengan
para peramal atau ahli nujum adalah termasuk
perbuatan dilarang. Dalam Islam misalnya;
Rasulullah  menyampaikan peringatan Allah
dalam hadits qudsi: "Siapa yang berkata hujan
karena bintang ini dan itu maka telah kafir
kepada-Ku dan percaya kepada bintang” (HR
Bukhari-Muslim) Juga Allah menegaskan
dalam Alguran, "Tiada suatu bencanapun yang
menimpa di bumi dan (tidak pula) pada dirimu
sendiri melainkan telah tertulis dalam kitab
(Lauhul Mahfuzh) sebelum Kami
mengadakannya. Sesungguhnya yang
demikian itu mudah bagi Allah." (QS 57:22).
Jodoh, rejeki, nasib manusia serta bencana
yang akan menimpa bukan karena posisi
matahari, planet atau bintang, tetapi karena
sunnatulah, ketentuan dari Allah. Jadi
sebaiknya kita jangan terlalu percaya dengan
ramalan-ramalan itu kalau tidak mau dibilang
sirik atau bahkan kafir??. Tapi kalau hanya
sekedar untuk ‘joke' atau permainan atau
hiburan saya pikir boleh-boleh saja. (Ashoka-
2007)

5. Asal-Usul
Perbintangan
Kata Horoskop di serap dari bahasa
yunani =,,horoskopos” yang berarti melihat
jam. Melalui waktu kelahiran seseorang bias di
tentukan lambing zodiac dari orang tersebut
juga bias diramal mengenai sifat kepribadian
maupun jalan hidupnya dari orang itu. Astrologi
atau ilmu perbintangan, kata ini juga diserap
dari kata yunani, dimana letak posisinya dari
berbagai benda langit mereka biasa
meramalkan nasibnya seseorang. Astrologi
sudah dikenal sejak jaman Babilonia sekitar
4000 tahun yang lampau. Pada saat sekarang
ini ada tiga macam astrologi yang cukup

Astrologi atau ilmu

dikenal aialah Astrologi barat, astrologi Tionghoa
(shio) dan Astrologi India (iyotisha).

Astrologi Tionghoa adalah astrologi yang
tertua, walupun mereka menggunakan hewan
sebagai lambing, tetapi ini tetap ada kaitannya
dengan ilmu perbintangan. Lima elemen utama
dari ramalan ini adalah Venus=metal (emas),
Jupiter-kayu,Mercury=air,Mars=api dan
Saturn=tanah. Seni ramalan yang sesungguhnya
dalam astrologi Tionghoa lebih dikenal dengan
sebutan Zi Wei Dou Shu (Ramalan Bintang Ungu).
Kalau kita mendefinisikan rasanya gula itu jelas
semuanya akan sepakat bahwa gula itu manis.
Tapi dalam soal ramal-meramal itu belum tentu.
Orang boleh memprediksikan waktu dan tahun
yang sama maupun letak posisi bintang yang
sama, tetapi hasilnnya bias berbeda.

Dalam istilah psikologi ini lebih dikenal
dengan sebutan Barnum efek atau Forer efek kita
otomatis bisa menerima dan mempercayai
pendapat seseorang, karena dari awal mulanya
kita sudah terpengaruhi. Misalnya apabila kita
membeli buku ramalan berarti secara tidak
langsung kita sudah terpengaruh dan percaya
bahwa buku ramalan ini ada manfaatnya bagi kita
oleh sebab itu untuk kelanjutannya kita akan
percaya bahwa apa yang ditulis dibuku tersebut
itu benar.

Di Eropa pernah diadakan test untuk
menguji para pakar astrologi, untuk mengetahui
dimana letak posisinya ke delapan planet-planet
besar, ternyata pengetahuan yang sedemikian
mudah dan mendasar sekalipun juga lebih dari
70% tidak dapat mengetahuinya. Bagaimana
mereka bisa menghitung dan mengartikan nasib
orang lain, apabila letaknya saja sudah tidak tahu
dimana?

Berdasarkan test lainnya yang dilakukan
oleh majalah Stern dari semua ramalan para
astrologi yang paling top di Eropa, ternyata dari
hasil keseluruhan ramalannya selama satu tahun
hanya tiga persen saja yang mungkin secara
kebenaran telah menjadi kenyataan alias jitu
ramalannya. Berbagai macam aliran agama
menilai, bahwa ramal-meramal itu haram, tetapi
apakah anda tahu bahwa koran Suara Merdeka
adalah koran online nomor tiga yang paling
banyak pengunjungnya, karena disitu kita bisa
membaca astrologi Jawa. Tidak bisa dipungkiri di
berbagai macam majalah wanita, yang menjadi
rubrik tetap yang ngetop adalah Horoskop. Dan
jawablah dengan jujur kalau kita tidak percaya
akan segala macam bentuk ramalan kenapa dilain
pihak kita selalu mencari hari dan waktu yang baik
untuk melakukan hari pernikahan, bukankah ini
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juga bisa disamakan seperti percaya akan
ramalan?

Nabi Jusuf menafsirkan ramalan dari
suatu impian, begitu juga banyak nabi-nabi
lainnya meramal; hanya mungkin istilah atau
sebutannya saja yang berbeda kalau kita pergi
ketukang kwamiah atau tukang ramal ini
disebut haram dan dosa, tetapi kebalikannya
apabila seorang pembimbing agama bernubuat
baca meramal ini tidak haram bahkan harus di
Amin kan.(Ki Agus.Com-2007). Salah satu
bentuk ramalan yang pernah ada dan masih
dipercayai sekarang adalah Kartu Tarot. Kartu
ini  berasal dari Iltalia. Pada awalnya,
permainan kartu tersebut bernama Carde da
Trionfi atau Kartu Kejayaan. Setelah mendapat
pengaruh dari Prancis, nama Trionfi berubah
menjadi Tarocchi. Antoine Court de Gebelin
dalam  bukunya terbitan tahun 1781
menyatakan kartu Tarot dibuat justru oleh
pendeta-pendeta  Mesir  kuno. Mereka
kemudian membawa gambar-gambar tersebut
ke Roma untuk dipersembahkan kepada Paus.
Paus kemudian memperkenalkan Tarot ke
Avignon, di Prancis pada abad ke-14. Gereja
dan pemerintah di Eropa tidak melarang
permainan Tarot. Beberapa daerah bahkan
memperbolehkan warganya memainkan Tarot,
padahal permainan kartu lainnya dilarang.
Berbicara tentang ramal-meramal tidak
mungkin melupakan peramal Prancis
terkemuka bernama Nostradamus. Michel de
Nostradamus seorang keturunan Yahudi yang
telah memeluk Katolik. Ketika berumur lima
belas tahun, ia belajar di Universitas Avignon.
la mempelajari tatabahasa, percakapan,
logika, geometri, aritmatika, seni musik dan
astronomi / astrologi.

Nostradamus juga mempelajari dunia
paranormal. Karena itu, ia bisa menulis
kalender pada tahun 1550. la pun mulai
terkenal dengan aneka tulisan ramalan. Ada
sekitar 6.338 ramalan (kebanyakan
ramalannya gagal) dan 11 kalendar. Meskipun
demikian banyak bangsawan dan orang
berpengaruh yang berminat untuk
menanyakan nasihat dan ramalan kepadanya.

Karena karangan ramalan dan
kalendern karyanya tidak bertarikh,
Nostradamus diancam oleh kaum beragama.
Salah satunya buku vyang berjudul Les
Propheties (ramalan), telah dikecam bila
diterbitkan. Masyarakat saat itu menuduh
Nostradamus sebagai pemuja setan, palsu
atau gila. la dituduh akan mewujudkan
ramalannya dengan kekuatan ilmu hitam.

Nostradamus yang berseberangan dengan kaum
beragama lalu membela diri dengan mengatakan
bahwa ramalan dan astrologi tidak termasuk
dalam kategori agama. Karena argumen
pembelaan dan ketaatannya pada otoritas religius,
Nostradamus kembali berhubungan baik dengan
kaum beragama. la hanya ditahan sebentar di
Marignane tahun 1561, karena menerbitkan
kelender tahun 1262 tanpa ijin otoritas religius. (A.
Luluk Widyawan-2005)

6. Desain Halaman Antar Muka
Adapun isi dari tampilan halaman beserta
strukturnya menjadi pedoman dalam mendesain.
Dalam mendesain suatu tampilan halaman harus
mempunyai format dan isi yang sesuai dengan
materi yangn akan di tampilkan dan kesesuaian
agar membuat tampilan halaman lebih menarik
dan enak untuk dilihat.
Dalam desain halaman pembuka Aplikasi
Ramalan ini pembuatannya menggunakan
Aplikasi Macromedia Flash MX Professional.
Karena Program Aplikasi ini merupakan software
animasi yang sekarang menjadi software favorit
para web designer untuk membuat webnya terlihat
dinamis dan lebih atraktif. Bahkan sekarang Flash
digunakan untuk berbagai keperluan, diantaranya
untuk presentasi, proposal modern, e-card, game
dan lain-lain. Tutorial ini ditujukan untuk para
designer yang sudah mengenal flash dan ingin
mengeksplorasi kehebatan flash, bagi yang masih
pemula.

7. Pembuatan Aplikasi
Dalam pembuatan Aplikasi Ramalan ini
menggunakan komputer multimedia meluputi
beberapa proses yaitu:

Pembuatan Objek

Pada proses pembuatan objek terdapat berbagai
cara pembuatannya. Pembuatan objek dapat
dilihat dalam berbagai program misalnya
Macromedia Director 8, Adobe Photoshop dan
Macromedia Flash MX. Karena Program yang
digunakan merupakan program yang paling
menonjol dalam Aplikasi ini, sehingga dapat
menampilkan background dengan warna yang
menarik, serta animasi yang sederhana tapi lucu
dan juga ditampilkan dengan program yang
mudah digunakan tapi menghasilkan tampilan
yang lucu yang menarik.

Proses Memotong Lagu (Cool Edit Pro)
Langkah-langkah dalam memotong lagu yaitu
sebagai berikut:
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1. Mengambil lagu yang akan digunakan
yaitu dengan Mengklik kanan pada
stage track->Insert>Wafe from file..

o £ Pre < Trist Ve 1 s o) ]
e

Frack Brogpartis

nEnOE e

B3 2002 Sy Sobvae Coponston 00 RekMery 10ZME 2851 GB e

Gambar Insert Wafe From File

2. Proses Reading _Iagu yang di pilih

PRmme mees  007.508

Stegped D DbdMeng  VEME 2BESGH e

Gambar Reading “mp3” File

3. Proses memetong lagu yaitu dengan
cara menahan Kursor  kuning
kemudia Mendrag pada bagian yang
akan di potong atau menekan Delete

= it v Cact 1 Py ]
Fie [t Vew Pt [fecs Opoors Fel

00 RMerg  TIEME 2855 ke

Gambar Cut File

4. Kemudian Mengklik  file  Save
Mixdown File untuk menyimpan File
lagu yang akan digunakan

Uniiest wew - Col £ Pro i
Bl v bt Wtes cotens 1

i L Sgace s Ty il

o

EmE M| 0:00.000

Oipenetin 11 71 seconds 100 CodMerg  VIEME LSGHbee

Gambar Save Mixdown File

5. Kemudian  muncul perintah  untuk
menyimpan tempat file lagu yang akan
digunakan, kemudian Mengklik Save

=N REEEE DREEEE

DmOE| e e .
PRmme e s 0:00.000

[ p— D Tty N0 BN

Gambar Tempat Perintah menyimpan File

6. Proses Saving Mixdown To File
» A

[ p— D Dy R NS

Gambar Saving Mixdown To File

Pembuatan Background Aplikasi Ramalan
(Adobe Photoshop CS)

Untuk pewarnaan objek grafis atau symbol grafis
digunakan program grafis yaitu PhotoshopCsS,
PhotoshopCS merupakan program grafis yang
khusus digunakan untuk penanganan warna serta
effek sebuah gambar yang dihasilkan dari kamera,
monitor televisi, atau komputer, proyektor film,
scanner, dan sebagainya. PhotoshopCS juga
menyediakan fitur-fitur serta effek-effek yang lebih
banyak dan lebih menarik daripada versi-versi
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sebelumnya dan yang mengalami

200 ya.

Gambar Tampilan awal Adobe PhotoshopCS

1. Akan muncul perintah setting publish
dan berikutnya tingggal mengklik oke
dan prose_s__pu_blish selesai

i

P P -
— St

P Scwna 1 Curend proliesDelaa = h, + 8 [ RED
 Tisatios Fornats |t | e | a

WPONOo A
LaRNO>P TS
paNTe
i
=
k‘li__h

4

a
o

SEIUBTITTT

L] o
“ioas

Gambar Proses Publish Setting

Pembuatan Tombol
(Macromedia Director)

Interaktif

8. Movie Script untuk Realtime Clock
1. Pada Cast member mengklik Script

waktu tersebut sebagai berikut:
Tampilan Parameter untuk Radio Button Group

2. Pada Property Inspector, panel
Script, Type mengatur menjadi Movie

X
i ¥ Property Inspector =
on 17
exitFra_ Internal —
me n!: == @
Scripk
Type: | Behavior .
Syntan:
AR B ehavior
Parent
==

Gambar Tampilan mengatur Type Panel Script

3. Play Movie untuk mencobanya
2. Ketikkan Sebagai berikut :

* ScriptDehavior Script 44 - E
+4+ 0O G @ [eena —
e x] | [mossetre

AT LEREDR e ®: 4 E

=true thes alert'mohon periksa kembali alac k

Gambar Tampilan Script pada Tombol panah
Halaman Menu

9. Halaman Akhir

1. Pada Halaman terakhir atau halaman
hasil hanya menuliskan text yang akan
jadi hasil ramalan nanti yaitu hanya
dengan menuliskan nama, text yang berisi
hasil ramalan, tombol (Dengan Script: go
“mulai”) dan Background

iw Script:Behavior Script 13 =
+ 4 v O

[ Linga | V] [ mausellp | v]

on mouzselp me
oo nualai
and

=i " ' ' ' v ' v

Gambar Tampilan Halaman Akhir

10. Proses Penentuan Halaman Akhir

1. Pada Frame 19, membuat frame Script
sebagai berikut:

i Scrnpt:Behavior Script 29 e

P =) [+ ) za [reernar =]
[Linas [=] | [ exitFrame [=] =| == =— L 3
on exitFrame me -
warnama=menber ["nama’) . text
msmlosi (22) . bext="=pma lalbar, *kwarnamab ?
wvarlahir=value menlker ["togllabhiz"s . texk)

hasil=varlahir mod &
caz= haszil of

Oigo “hasill®

ligo "ha=zilz"

Zige “hasilz"

Sigo "hasilan

4:ige "hazilb5"

Sigo “hasila"
end cas=e

end -

) >

Gambar Tampilan Script pada halaman hasil

Keterangan :

a. Varnama=member(“nama”).text
Artinya: variable varnama di ambil dari
text field nama (di halaman input)

b. Member(22).text="apa
kabar,” &varnamag&” ?”
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Artinya: text di member 22 ( di
halaman hasil) akan berisi “apa kabar
di tambah variable varnama”
c. Varlahir=value(member(“tgllahir”).te
xt)
Artinya: variable varlahir adalah
numeric yang diketik ini field tgllahir (di
halaman input). Variable varlahir paling
besar adlah angka 31 karena sudah di
batsi script pada tombol hasil
d. Hasil=varlahir mod 6
Artinya: variable hasil akan
menghasilkan angka antara o sampai

11.Tahap Pasca Produksi
Tahap pasca produksi terdiri dari tahap
publikasi, dan tahap keluaran.
16.Tahap Publikasi

Tahap publikasi adalah tahap untuk
mengubah program atau aplikasi yang dibuat
menjadi format *.EXE dan perubahan inilah
yang dinamakan file Executable atau Projector.
Langkah untuk tahap publikasi, sebagai berikut

1. Terlebih dahulu Save proyek yang
telah yakin kita buat, klik menu File 2>
Save dan kemudian beri nama seperti
yang anda kehendaki

Save Movie [ JO
Savein:[ 0K |Vl > & £ [

Transition
& Ramalan oke.dir
&/ Ramalan_ADE.dir

File: name:

| Save
| V] Caniel

Gambar Save Movie

Save as type: [ Directar Mavie

2. Kemudian membuat file Executable
(*.exe), klik menu File > Publish
Setting pilih file Ramalan oke.dir, akan
tampil kOta!ﬁ.,.ﬂii!&g sebagai berikgt:

O C OO

gooog

Gambar Publish setting

3. Akan ada tampilan Progress bar selama
beberapa detik, yang menandakan karena
komputer sedang bekerja, sebagai

berikut:
1] ] e “Wer» TJHIOW AR =
@
i w Stac
—
Creating projector i ipsil " )

19 of 19 files added

[ Shockwave File (DCR]

Ramalan der

[CIHTML
Gambar Creating Projector
12.Implementasi

Setelah tahap parancangan dan
pembangunan dari Aplikasi Ramalan ini selesai,
maka langkah penting selanjutnya adalah
mencoba dari hasil Aplikasi Ramalan itu sendiri
untuk mengetahui aktifitas dan efisiensi Informasi
yang di sajikan. Dengan melihat hasil jadi dari
pembelajaran interaktif ini akan dapat mengetahui
kekurangan dan meminimalisir kesalahan yang
terjadi.

Cara menjalankan Apliksi ramalan ini
yaitu dengan cara mengklik ganda pada icon
Aplikasi Ramalan pada layar Desktop yang telah
ditampilkan.

13.Tampilan Intro

Setelah mengklik ganda pada icon maka
ditampilkan intro awal Aplikasi Ramalan yang
diiringi Backsound musik dan Animasi.

Peramal cantik no. 1 dari toliz

Gambar Halaman Intro dan Pembuka

14. Tampilan Halaman Input

Halaman Input Aplikasi Ramalan ini
adalah dimana pengguna langsung dapat
menggukan dengan mengisi Biodata yang telah
disediakan yaitu dengan mengisi Nama, Tanggal
Lahir, Bulan, Tahun dan Jenis Kelamin dan
kemudian terdapat satu tombol menuju halaman
Hasil.
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15. Tampilan Halaman Hasil

Setelah menekan Tombol hasil maka
akan menuju Halaman Hasil Ramalan , dimana
disitu terdapat hasil ramalan si pengguna. Dan
terdapt 2 tombol menuju Halaman Biografi dan
kembali menuju kehalaman input

16.Uji Coba

Uji coba film yang telah di buat di lakukan
dengan cara memainkan game, Yyang
selanjutnya memberikan kuisioner kepada 30
orang pemakai Aplikasi Ramalan. Kuisioner
merupakan daftar pertanyaan yang disusun
sedemikian rupa, sehingga pengisi bebas
menyatakan pendapatnya. Jenis Kkuisioner
yang digunakan adalah kuisioner tertutup, yaitu
kuisioner yang disusun dengan menyediakan
pilihan jawaban.

17. Kesimpulan
1. Aplikasi Ramalan Bintang berbasis
multimudia yang dibuat dapat

memnyemarakkan Aplikasi
Ramalan sebelumnya yang
menggunakan Bahasa
Pemrograman Basic dan
sebagainya

2. Aplikasi Ramalan Bintang Berbasis
Multimedia tersebut dapat

digunakan sebagai salah satu
hiburan interaktif serta dapat
diambil nilai positif yang ada di
Aplikasi Ramalan tersebut.
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